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Chapter 1. Setting Up the RF ValProbe
Chapter 1. Setting Up the RF ValProbe

1.1 Introduction

1.1.1 Unpacking

Unpack the Kaye RF ValProbe Loggers and Base Station carefully and 
inspect them for any damage that may have occurred during shipment. If 
there is shipping damage, notify the carrier immediately. Verify that the 
following are present:

• Kaye RF ValProbe Base Station 

• USB to Ethernet Cable

• Base Station Power cord and Adapter

• Cal PC USB cable

• IRTD and Bath cables

• Kaye RF ValProbe Loggers and calibration certificates

• Logger Power Adapter

• Logger USB cable

• Kaye RF ValProbe Software Package

1.1.2 Safety Information

Use this instrument only as specified in this User Manual.

• The protection provided by the equipment may be impaired if the equipment is used in 
a manner not specified by Kaye.

• Do not use this equipment in environments other than those listed in this User Manual.
RF ValProbe® User Manual 1



 Chapter 1. Setting Up the RF ValProbe
1.1.3 Overview

The Kaye RF ValProbe II system is a wireless thermal validation system that 
collects temperature and humidity data. The Kaye RF ValProbe system is 
designed for accurate, convenient, and reliable process validation of 
environmental chambers and storage areas. These applications include 
stability chambers, freezers, refrigerators and warehouses. A 2.4-GHz RF 
mesh network and multiple-redundant data storage support communications 
and storage of critical validation data, while safeguards guarantee data 
integrity, storage and compliance with regulatory requirements.

The system consists of Kaye RF ValProbe II Loggers, a Kaye RF ValProbe II 
Base Station, and Windows-based software for programming and reading the 
Loggers, calibrating Loggers, verifying their calibration, and generating 
reports (see Figure 1 below).

Data from multiple wireless Loggers is combined in a single file from which 
reports are generated. These reports are designed for implementation of 21 
CFR Part 11 requirements for electronic records. Users can customize the 
reports by defining process cycles and specifying cycle-based calculations.

Figure 1: The Kaye RF ValProbe II System
2 RF ValProbe® User Manual



Chapter 1. Setting Up the RF ValProbe
1.1.4 The Kaye RF ValProbe II Base Station

The RF ValProbe Base Station acts as the communications link between the 
wireless Loggers and the RF ValProbe software on the computer. When 
connected to the computer via Ethernet, or USB-Ethernet adapter, the Base 
Station programs, reads and collects data from up to 40 Loggers per study. 
Its design ensures reliable transfer of critical data. If the PC is not present or 
currently running, the Base Station can store data from up to a maximum of 
40 Loggers.

Powered by a power supply rated from 100-240 VAC at 50/60 Hz, the Base 
Station (shown in Figure 2 below) includes an Ethernet connection.)

Figure 2: RF ValProbe II Base Station

CAUTION! Use only the Kaye power supply (Kaye #201-3003) provided with 
your RF ValProbe II. The use of non-factory power supplies may 
damage the equipment and will void your warranty.
RF ValProbe® User Manual 3
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1.1.5 Base Station Batteries

Kaye RF ValProbe II base station has battery backup for up to 10 minutes. 
The base station is powered by two 3.7V AA size rechargeable Lithium 
batteries. Kaye RF ValProbe base station has a built-in charger, so batteries will be 
charged automatically when there is a main supply available to the base station. To 
replace the batteries, first shut off the base station using ON-OFF switch. 
Then open the sliding panel on the back of the base station and replace the 
batteries in the compartment shown in Figure 3 below. Do not turn the base 
station back on until you have properly replaced the compartment cover.

Figure 3: RF ValProbe II Base Station Battery Compartment

CAUTION! ONLY Use Kaye #200-166 3.7 V lithium secondary (rechargeable) 
batteries. Using any other batteries will render the stated performance 
void as Kaye #200-166 3.7V batteries are the only brand tested and 
accepted. 

{Insertion of non-rechargeable Battery might cause the over-heating 
and explosion}.
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1.1.6 Kaye RF ValProbe II Temperature/Humidity Loggers

The wireless RF ValProbe II Loggers use an external temperature sensor. 

• The humidity sensor covers a range from 25% to 85% RH, with accuracy of ±2.0% at 
25°C to 40°C. 

• For validation, the external temperature sensor maintains accuracy of ±0.1°C from 
-50°C to + 130°C; extreme lower temperature, the sensor is accurate to ±0.2°C from 
-80°C to -50°C (See Appendix A for full accuracy specifications).

Figure 4: The RF ValProbe II Logger with External Sensor

Each Logger can record up to 10,000 readings per sensor or input; the data 
is sent to the Base Station and stored simultaneously in the Logger and 
Base Station memories. When prompted by the RF ValProbe software, the 
Loggers send this data to the computer via the Base Station for reading into 
a study, report creation and data calculation.
RF ValProbe® User Manual 5
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1.1.6 Kaye RF ValProbe II Temperature/Humidity Loggers (cont.)

Two Green LEDs —Power and the RF Link light — indicate Logger status.

• When user presses the Status button, the green Power light appears to show that the 
Logger is receiving sufficient power.

The green RF Link signal indicates four stages of RF connectivity, when user Press & 
holds Status button:

1.  RF Link LED is in off condition before it attempts to connect to the network.

2.  The next signal is slow blink as the Logger scans the area for a network (Base
   Station or Logger) connection.

3.  A double blink indicates that the Logger has found the RF link and trying to
     establish the RF connection, either to another Logger or to a Base Station.

4.  Fast blink / solid green indicates RF connection is successfully established.

Note: Solid green light indicates that the Logger has made two separate connections in 
a network, which is preferred mode of operation.
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Chapter 1. Setting Up the RF ValProbe
1.1.7 Logger Buttons

Logger has three Buttons, Scroll UP, Scroll Down and Status Button at front 
Keypad. Logger also has reset switch and micro SD card option at bottom 
side of the logger as shown in the figure 6 below, different functionalities of 
the buttons are stated in the Table 1.

Figure 5: RF ValProbe II Logger Keypad

Figure 6: RF ValProbe II Logger Reset, SD Card and USB/AC Power 
Connections

RF Link

Scroll 
UP

Scroll 
DOWN

Power

Status

USB / AC Power Port

Reset Button

SD Card Slot
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Table 1: RF ValProbe Logger Buttons, Reset Functions

Action
Button Usage

Scroll 
Up

Scroll 
Down Status Reset

Back light 
ON/OFF1

Hold Scroll UP + Down 
button for 1 second ■ ■

Dump Data 2,3 to 
SD Card

Hold Reset Switch for 1 
Second ■

Scroll Sensor Next 
Channel Click on Scroll UP Button ■
Scroll Sensor 
Previous Channel

Click on Scroll DOWN 
Button ■

Status1 Click on Status Button ■
Reset Mode Hold Reset Switch for 10 

Seconds ■
Logger Join Click on Status Button ■

Change to °C

Switch off the logger, Press 
Scroll Down Button while 
switching ON logger and 
Hold Scroll Down Button for 
10 Seconds

■

Change to °F

Switch off the logger, Press 
Scroll Up Button while 
switching ON logger and 
Hold Scroll UP Button for 10 
Seconds

■

Reset Battery Hold Status Button for 5 
Seconds and Power On ■
8 RF ValProbe® User Manual



Chapter 1. Setting Up the RF ValProbe
1.1.8 Logger Display

The LCD is turned off if no activity is performed for predefined duration (30 
seconds on Battery and 15 Minutes on USB Power). When a button 
combination (ScrollUp +ScrollDown) is pressed on the logger keypad for 1 
sec the beep indicates that buttons could be released and the LCD 
Backlight glows and same combination is used to turn OFF the Backlight. 
Pressing the STATUS button turns ON the LCD and the previous data 
displayed is resumed. Logger LCD view is shown in Figure 7 below. LCD 
display refresh rate follows the sampling time set by validation software. 
Logger follows 1 minute display refresh rate when logger is not in study. 
Alternatively logger display updates upon pressing status button.

LCD Display 
Refresh 1,4 Click on Status Button ■
Notes:

1. Frequent pressing of the status button / use of LCD will impact battery life.
2. Data will not be read from SD card if sampling rate is <30 sec.
3. Insert SD card in Logger only during data recovery and remove upon copy of data, 
    SD card operation will impact battery life.
4. LCD will not refresh sensor values if sampling rate is <10 sec

Table 1: RF ValProbe Logger Buttons, Reset Functions
RF ValProbe® User Manual 9



 Chapter 1. Setting Up the RF ValProbe
Figure 7: RF ValProbe II Logger Display

RF Connectivity 
and Strength

Study Mode

SD Card Presence

USB Connectivity

Firmware Version

Network ID

Contact Switch 
Output

Battery Status

AC Adaptor Status

Channel Number

Reading of Active 
Channel Number

Parameter of 
Displayed Value

Parameter Unit
10 RF ValProbe® User Manual



Chapter 1. Setting Up the RF ValProbe
1.1.9 Logger Power

The Logger can be powered by two 3.6 V, AA lithium non-rechargeable 
batteries (Kaye #200-165) or a power supply (Kaye #201-3002) rated from 
100-240 VAC at 50/60 Hz, shipped with the Logger. To replace the batteries, 
first shut off the Logger by sliding the power switch (shown in Figure 8 
below) to OFF position. Then open the sliding panel on the back of the 
Logger and replace the batteries in the compartment shown in Figure 8 
below. Do not turn ON the Logger (sliding the power switch to ON position) 
until you have replaced the compartment cover.

CAUTION! 1. If it becomes necessary to replace a Logger battery, use only a Kaye 
#200-165 3.6 V lithium Primary (Non-rechargeable) battery. Use of any 
other battery will void your Logger warranty and Battery Life.

2. Use only the Kaye power supply (Kaye #201-3002) provided with your 
RF ValProbe. The use of non-factory power supplies may damage the 
equipment and will void your warranty

Figure 8:  Logger Battery Compartment / Network ID and ON/Off Switch
RF ValProbe® User Manual 11
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1.1.9 Logger Power (cont.)

Battery life is affected by number of factors, including sampling rate, 
Environmental temperature, Logger position in the network, and hours of 
use. In addition, individual battery characteristics and capacity vary 
inherently from one battery to another by up to 10%. The RF ValProbe 
software tracks each Logger's battery life to within 10% of a potential 
low-voltage occurrence to help prevent interrupted or incomplete studies. 
When determining the battery life remaining, the software bases its 
calculations on the assumption that the battery can supply a predictable 
amount of energy (mAh) over the temperature range.

The battery life calculation is accurate when a Logger is used exclusively for 
studies at or above room temperature, or exclusively for studies below room 
temperature. Kaye therefore recommends that you change the battery when 
switching between temperature ranges above room temperature and those 
below room temperature.

A low battery warning is issued when the remaining battery life is below the 
warning percentage specified in the RF ValProbe software. The low battery 
warning is issued until you replace the Logger battery and reset its battery 
life to 100%. If you do not specify a percentage, the low battery warning is 
set to 10%. Kaye recommends that you replace the battery when there is 
10% battery life remaining.

• If the battery is used up or is removed, the study setup and data, as well as the 
calibration information, are maintained in non-volatile memory inside the Logger

1.1.9a Resetting the Battery Capacity Setting

You can reset the battery capacity from the Logger itself. Once you have 
installed the new batteries, press and hold the Status button on the front of 
the logger while you turn the logger power switch on. Wait for the Power 
(green) light to blink five times, and then release the button. The battery 
capacity has been reset.
12 RF ValProbe® User Manual
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1.2 Calibration

1.2.1 Calibration Data Storage

Calibration data, including calibration offsets, and when the calibration was 
performed and by whom, are stored in the Logger in non-volatile memory. 
The data remains intact even if the battery is exchanged. 

1.2.2 Verifying Calibration

The Kaye RF ValProbe software allows you to verify Logger calibration at 
one or two set points. For Humidity/Temperature Loggers, each sensor type 
must be verified independently. You may want to verify that the Loggers are 
within their specification before running a study; however, you do not need to 
recalibrate them. Since the RF ValProbe is a self-contained instrument, the 
sensor and instrument errors are accounted for during factory calibration.

The following section provides an overview of verifying Logger calibration. 
The online Help that comes with the Kaye RF ValProbe software provides 
step-by-step instructions on calibration procedures. 

Note: In the RF ValProbe software, you can select either manual or automatic calibration 
verification. If you select automatic calibration verification, you will not need to 
enter stability or deviation criteria; however, you will still need to connect your 
computer to a Kaye IRTD temperature probe and to a temperature bath via the 
Kaye RF ValProbe base station (included with the IRTD). You will also need to enter 
set points, and to click the Start Calibration button.
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1.2.3 Required Equipment

When verifying sensor calibration, you must consider the measurement 
uncertainty of the equipment you are using in combination with the 
uncertainty of the equipment used by Kaye to calibrate the Loggers at the 
factory.

For example, if you verify calibration for a Logger's humidity sensor using a 
calibration chamber with a measurement uncertainty of ±1.5% RH, and the 
Kaye chamber has a measurement uncertainty of ±1.0% RH, you may obtain 
a deviation greater than the 2.0% RH specified by the factory as the 
accuracy of the sensor.

The Certificate of Calibration that was shipped with each Logger provides 
detailed information about the equipment used by the factory to calibrate the 
Loggers, including the measurement uncertainty. (Auxiliary inputs are 
shipped with additional certification documents.) The equipment required to 
accurately verify calibration for each sensor type is listed on the next page.

1.2.3a Temperature Sensors

In order to verify that the temperature sensors in the Loggers are within the 
±0.1°C calibration accuracy for -50°C to + 130°C; ±0.2°C from -80°C to 
-50°C (See Appendix A for full accuracy specifications). The total system 
measurement uncertainty for the calibration equipment must be better than 
33mK (0.033°C) in order to achieve a 3:1 measurement uncertainty ratio. 
The following equipment is required to perform calibration verification:

• IRTD model 400 (25mK). The IRTD 400 (M2801) temperature measurement 
standard is a self-contained measurement system providing temperature data 
directly to the Kaye RF ValProbe software during temperature sensor 
calibration and calibration verification. The measurement accuracy is 
NIST-traceable to 0.025ºC, with a range of –196ºC to 420ºC.The IRTD provides 
a traceable standard that is used to calibrate Kaye RF ValProbe Loggers and 
to verify Logger calibration. During the calibration and calibration verification 
process, the Kaye RF ValProbe software automatically reads and monitors the 
value of the IRTD probe.
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Note: During calibration, the IRTD remains connected (via a Cal PC USB port shown in 
figure) to the PC running RF ValProbe software, and to the temperature chamber or 
bath. Connect both IRTD and BATH via the ports on RF ValProbe base station shown 
in the figure 9 below.

Figure 9: RF ValProbe Base Station

Temperature bath or chamber with the following stability and uniformity 
specifications:

Kaye recommends using the CTR-40 or CTR-80 liquid calibration baths. 

1.2.3b Humidity Sensors

In order to verify the RH sensors meet the calibration accuracy specification, 
the RH Humidity Calibrator must have an error equal to or better than ±1%. 
To perform calibration verification, Kaye recommends a Humidity Calibrator 
with ±1% accuracy or better, such as the Kaye Humilab. Or any Salt Bath.

Table 2: Temperature Bath (Chamber) Specifications

Bath Stability Bath Uniformity

7mK 7mK
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1.3 Setting Up the RF ValProbe System

Setting up an RF ValProbe system for operation involves five steps:

1. Installing the RF ValProbe software for validation

2. Setting up the Base Station

3. Connecting any External Sensors or Auxiliary Inputs

4. Setting up and positioning the Loggers

5. Starting the RF ValProbe software

1.3.1 Setting Up the Base Station

Starting the Base Station requires plugging in the power supply and 
establishing Ethernet connection. The rear of the Base Station appears 
similar to Figure 10 below. The newer Base Stations do not have the USB 
port, but a high-speed USB-Ethernet cable, included in your RF ValProbe, 
will connect the Ethernet port on the Base Station to the USB port on the PC.

Figure 10: Base Station Connections

Power USB Ethernet
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1.3.1 Setting Up the Base Station (cont.)

• To power the Base Station, insert the round barrel connector into the power input jack 
of the Base Station (the input at the left shown in Figure 10 on the previous page). 
Attach the power supply to the power cord.Then insert the power cord into a standard 
100-240 VAC outlet and switch on the base station using ON-OFF switch on the unit. 
A green light on the Base Station keypad indicates that the station is powered up.

IMPORTANT:The external power supply included with your RF ValProbe is fitted 
with an AC power cord suitable for the country of destination.

• To establish an Ethernet connection, plug one end of your Ethernet cable into the 
outlet left to the power outlet shown in Figure 10. Then plug the other end into your 
Ethernet connection.

• To establish a connection using the adapter, connect the crossover cable to the 
USB-Ethernet adapter. Plug the crossover cable to the outlet left to the power outlet 
shown in Figure 10. Then plug the adapter to the USB port on your PC.

Once you have established the connection and set up the loggers (see section 1.3.3), 
start the RF ValProbe software. 

Base Station will restore all its factory settings after pressing RESET switch shown 
in Figure 10 for 5 seconds.

CAUTION! This switch is intended only for service. Pressing of RESET 
switch will restore the Base station to factory settings, loss of 
join key and Network ID, restore to default IP. Also base station 
warranty. This is covered with a sticker for unauthorized use.
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1.3.2 Connecting an External Sensor and Auxiliary Inputs

If any of your Loggers are designed for use with an external sensor, that 
sensor will have been shipped with the Logger.

To connect the sensor to the Logger, simply remove the sensor cover, retaining 
bar, remove the terminal block for the existing sensor, and attach the 
terminal block of the new sensor, and replace the retaining bar and cover.

CAUTION! When handling external sensors, avoid bending the sensor near either 
the tip or connector ends. Repeated bending will damage the sensor.

User can connect auxiliary inputs (4-20 mA, 0-10V or contact closure) at 
the connectors of the Logger shown in Figure 11 below.

Figure 11: Inputs Description for Auxiliary Input and 5CH RTD Loggers

Note: For a 2 or 5-channel Logger, the sensors are pre-wired to terminal blocks inside the 
Logger. To replace or reattach a sensor, you must remove the cover and retaining 
bar, remove the terminal block for the existing sensor, and attach the terminal block 
of the new sensor, and replace the retaining bar and cover.

RTD1

RTD2

RTD3

RTD4

RTD5

RTD1

0-10V 
Input

Contact 
Input

4-20mA 
Input
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1.3.2 Connecting an External Sensor and Auxiliary Inputs (cont.)

Logger has detachable RH sensor module, push RH sensor towards left to 
remove from the Logger. RH sensors can also be connected via 3.3 ft. (1m) 
/ 10 ft. (3m) extendable RH cable. (Accessory with RFVP ValProbe system).

Figure 12: Detachable RH Sensor

Note: Each RH sensor is calibrated with respective logger. Any interchange of RH 
sensor will void the calibration data stored inside the logger.

1.3.3 Setting Up the Loggers

When you are setting up the Loggers, you must first be sure that they are 
switched on, and that they have the same network ID (from 0 to 9 or A to F) 
as the Base Station. (For example, all Loggers must have the network ID “5” 
if the Base Station has the ID “5”.) 

To switch the Logger ON, see the back of the Logger above the battery 
panel, as shown in Figure 5 on page 7. Slide the switch below the network 
ID wheel to the right to turn ON the logger. 

RH
Sensor
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Note: All Base Stations and Loggers are shipped with an initial Network ID of 0. To 
change the Base Station Network ID, install the RF ValProbe software and refer to 
“Selecting a Communications Option and Establishing Preferences” on page 36.

If you need to adjust the Logger’s network ID, use a small screwdriver to 
turn the arrow in the middle of the network ID wheel in Figure 5 on page 7. 
Be sure the arrow points to the appropriate ID number. (You can choose 
from numbers 0 through 9, and letters A through F.)

Note: You must change the Logger network ID before you switch on the Logger. If you 
have already switched the Logger on, switch it off and then turn it back on so the 
Logger can read the correct ID. 
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1.3.4 Logger Installation Guidelines

You can now position the Loggers. Each Logger must be no more than 
150ft (45m) distant from the Base Station and the other Loggers, there 
should not be more than three interconnections of logger to base station 
(hops, see below). Kaye offers several recommendations for logger 
placement:

• Install the Loggers at least two meters and Base station at least one meter above the 
ground or floor. For better RF transmission, place them as high as possible. If possible, 
raise or lower the Base Station and Loggers above or below walls or any separation.

• Point the Logger antenna upwards for best results.

• Do not position the Loggers directly above or below each other. Stagger their positions 
for better transmission.

• If Loggers are placed at different heights, make sure that they are within antenna range 
(within 150ft (45m) from the Base Station or another logger). The RF signal is 
transmitted in an arc, with maximum signal strength occurring in the area 45° above 
and below the tip of the antenna.

• Be aware that metal surroundings can interfere with RF transmission; the Logger may 
transmit, but the signal will be weaker. Shorten the transmission distance accordingly.

• Do not install Loggers next to a cordless phone base or other 2.4 GHz transmission 
device.

• Do not install Loggers on a vibrating surface.

• Do not place Loggers where the temperature is outside their rated operating range.

IMPORTANT: Maximum number of hops in typical network shall not exceed four. 
In a typical network, maximum interconnections of logger to base 
station shall not exceed three. Loggers need to be placed such a 
way that, maximum of three nodes connecting to base station from 
farthest logger for better RF performance.
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1.3.5 Repeater Installation

Install repeaters between Logger to Logger / Base station to Logger when 
the distance is more than 150 ft. or RF signal strength is low, if setup does 
not have any loggers in between that range, physical repeaters can be 
easily identified as it is a non-LCD variant as shown in figure 13 below.

Figure 13: Repeater
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1.3.6 What’s Next?

Once you have connected the Base Station and positioned the Loggers, 
proceed to Chapter 2 to use the RF ValProbe software and begin taking 
measurements.
RF ValProbe® User Manual 23



 Chapter 1. Setting Up the RF ValProbe
24 RF ValProbe® User Manual



Chapter 2. Installing and Using RF ValProbe Software
Chapter 2. Installing and Using RF ValProbe 
Software

2.1 Introduction

Before using the Kaye RF ValProbe system, you have to install the RF 
ValProbe software on your PC and perform some basic system 
administration tasks.

When RF ValProbe is installed for the first time, user is asked to select RF 
hardware to be used. The selection is valid until user decides to switch the 
RF hardware from Preferences tab by selecting “Change to BaseStation” 
check box. Software will restart and a screen will appear to select the RF 
hardware. 

Main Menu of RF ValProbe software will appear after appropriate selection of 
RF hardware.

The RF ValProbe software includes a Password Maintenance utility that 
allows a user with System Administrator permission to create and maintain 
user accounts and set site options.

A default System Administrator account is included with the software. You 
use this account to initially log in to the Password Maintenance utility and 
create your own System Administrator account. The default account is 
deleted once your own System Administrator account is created. You can 
then use your own account to perform all your system administration tasks.

In this chapter you:

• Install the RF ValProbe software, configured for network or local applications

• Start the program and log in to the Password Maintenance utility using the default 

System Administrator account

• Set site options

• Create your System Administrator account
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• Create Supervisor and Operator accounts

• Print the active user list

• Select the Communications Option and other Preferences

• Check system functioning on the Hardware screen

• Access the RF ValProbe online Help

2.2 PC Requirements

To run the RF ValProbe Windows-based software, your PC should meet the 
following minimum requirements:

• Pentium or equivalent microprocessor with 1 GHz processor speed and at least 1 GB 

RAM

• At least 40 GB hard disk space available

• Windows 7 Professional (32 bit or 64 bit), Windows 8.1 (32 bit or 64 bit) Professional and 

Windows 10 Professional (32 bit or 64 bit)

• Microsoft Office 2010, 2013 (32 bit only) and 2016 (32 bit only) for reporting

• One unused USB port for communicating with the Base Station or an Ethernet 

connection

• One unused USB port for built in calibration interface

• Windows printer with graphical printer capability

• VGA color monitor with resolution at least 800 X 600. If you are performing a 

calibration:

• One Cal PC cable (USB A-A) for IRTD communication and the built in Kaye calibration 

interface in Base station
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2.3 Installing RF ValProbe Software

When RF ValProbe is installed for the first time, user is asked to select RF 
hardware to be used. The selection is valid until user decides to switch the 
RF hardware from Preferences tab by selecting “Change to BaseStation” 
check box. Software will restart and a screen will appear to select the RF 
hardware. 

Main Menu of RF ValProbe software will appear after appropriate selection of 
RF hardware.

In addition to standalone operation, Kaye RF ValProbe offers the option of 
configuring the software for network capabilities. The RF ValProbe data files 
can thus be saved to and reported on from a central network location, rather 
than stored on each individual PC's hard drive. In addition, by enabling 
network capabilities, the RF ValProbe software will utilize one central 
password database for managing user names and passwords. You can then 
manage passwords for all your users in one place, rather than having a 
different password database on each PC running the Kaye RF ValProbe 
software.

Note: Network installations may not use the distribution set. Instead, users 
must create a customized network folder.

• If you are installing Kaye RF ValProbe to a network drive (from which you will install it to 

individual PCs), proceed to “Installation for a Network Application” on the next page.

• If you are installing Kaye RF ValProbe to an individual PC, proceed to “Installation for a 

Standalone Application” on page 30.
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2.3.1 Installation for a Network Application

• Be sure the network drive is mapped on your PC. On the drive, identify or create a 

network location (folder) to hold the RF ValProbe installation and data files. This 
location will also provide a central database for managing user names and passwords. 
The folder should be protected against data deletion.

• Insert the RF ValProbe CD into your CD-ROM drive. If the installation does not 

automatically begin, complete the following steps:

Click Start on the Windows task bar, and then click Run.

Click Browse. From the Browse dialog box, select your CD-ROM drive, click 
Setup.exe, and then click Open.

• Follow the on-screen instructions to perform the installation.

• Click on the appropriate installation path to install Kaye RF ValProbe to the network 

drive.

• Once installation has completed, the Kaye RF ValProbe Initialization program will run 

automatically. The Kaye RF ValProbe splash screen will appear, followed by the two 
System Administrator Site Options screens -- Policies and Preferences.
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2.3.1a Setting Up Site Options

When you start up the program for the first time, you will first set up the 
System Administrator Site Options, which provide more flexibility while 
running the RF ValProbe software. You can enable any combination that your 
site supports.

• Set a login timer for user identification. The login timer allows users, after initial 

identification, to enter only their password if user identification is within the preset time 
limit. When this option is enabled, the login timer can be set from 1 to 15 minutes.

Note: If you enable this option, the Time Interval readout displays to the right of 
that option, and the timer is initially set to 5 minutes. You can set the timer 
from 1 to 15 minutes using the spin buttons.

• Require minimum-length passwords for all user accounts, from 6 to 16 characters.

Note: If you select this option, use the spin buttons to set the requirement from 6 
to 16 characters. The password expiration requirement can be set from 1 to 
366 days with the spin buttons. Click the spin buttons once to move in 
1-day increments, or click and hold to move in 10-day increments.

• Set passwords to expire after a number of days, up to 366. Users will be prompted to 

change their password once their current password has expired. By default, passwords 
are set to expire after 180 days. The software will display the password expiration date 
to the user at login when there are five days or less until their password expires.

• Disable user accounts after 3 unsuccessful login attempts. This option will disable a 

user account if there are three consecutive PC login failures for the same user ID. If a 
user's account is disabled, the System Administrator must enable the account and 
assign a new temporary password. This option does not affect logins from the RF 
ValProbe instrument panel.
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2.3.1a  Setting Up Site Options (cont.)

• Display User ID during entry. By default, the user ID is shown to the user when logging 

in. Clearing this option will replace the user ID characters with asterisks (*****).

• Allow Operators to change Preferences. Preferences are workstation defaults that 

specify the temperature units (Celsius or Fahrenheit), the COM port, and when to issue 
low battery warnings. Any changes made to the system preferences are effective 
immediately, and all setups created after the preferences have been changed will 
reflect these new settings. If this option is not enabled, the System Administrator is 
responsible for changing preferences

• Disable the password system. User IDs and passwords will not be required to use the 

software.

Note: If you select this option, the Kaye RF ValProbe system will not enable 
compliance with 21CFR Part 11 requirements for electronic records.

Click the check box next to any option that you want to enable. An X appears 
in the check box when the option is enabled. Click the check box again if you 
want to disable it. The check box will be blank. Once your site options have 
been set, click on the Preferences tab.
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2.3.1b Establishing Site Preferences

The Preferences tab has the following settings that can be initially set for all 
users who install Kaye RF ValProbe software from the network:

• Select temperature units (Celsius or Fahrenheit) for all temperature calculations

• Enter the Company Name.

• Specify the data directory, which will be the default location for storing and retrieving 

data files and storing the password database. Navigate to the location on the network 
you identified to store the data files. This folder should be protected against file 
deletion.

• Allow users to specify the lethality criteria for calculation in reports. Select the desired 

options, and click OK.

2.3.1c Completing Installation

Click Finish to complete the initialization program.

Return to the Windows task bar. Click Programs, then Kaye RF ValProbe, 
and then RF ValProbe.
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2.3.2 Installation for a Standalone Application

1. Insert the RF ValProbe CD into your CD-ROM drive.

2. If the installation does not automatically begin, complete the following steps:

a. Click Start on the Windows task bar, and then click Run.

b. Click Browse. From the Browse dialog box, select your CD-ROM drive, click 
Setup.exe, and then click Open.

3. Click on the appropriate installation path to install Kaye RF ValProbe to your PC.

4. Follow the on-screen instructions to perform the installation.

5. Once installation has completed, the Kaye RF ValProbe Initialization program will run 
automatically. The Kaye RF ValProbe splash screen will appear, followed by the two 
System Administrator Site Options screens -- Policies and Preferences. Select the 
desired Site Options (as discussed on page 27 through page 29), and click OK.

6. Click Finish to complete the initialization program.

7. Return to the Windows task bar.

8. Click Start, then Programs, then Kaye RF ValProbe, and then Client Setup.

9. Click on the appropriate installation path to install the client to your PC.

10.  Follow the on-screen instructions to finish the installation.
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2.4  Starting the RF ValProbe System

To start up the RF ValProbe system for the first time:

1. Power up the Base Station, having connected it via USB to your PC.

2. Position and switch on the Loggers, with any external sensors or auxiliary inputs 
connected.

3. To open RF ValProbe validation software for the first time, click Start >Programs>RF 
ValProbe>RF ValProbe.

4. The identification required dialog box (shown in Figure 14 below) appears.

Figure 14: Identification Required Box

5. Enter Kaye in the User ID text box.

Kaye is the default System Administrator user ID. The User ID text box is case 
sensitive, so make sure you enter the default user ID exactly as it appears 
here.

Note: Note:To access the Password Maintenance utility after your initial login, 
click Start >Programs > RF ValProbe > RF ValProbe Utilities. Then click 
Site Options, and enter your System Administrator user ID and password 
in the System Administrator Log In dialog box.

6. Enter 411 in the Current Password text box. 411 is the default System Administrator 
password.
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2.4 Starting RF ValProbe (cont.)

7. Click OK. The Password Maintenance Add New User screen appears, as shown in 
Figure 15 below.

Figure 15:  Password Maintenance - Add New User Screen

You are now ready to create your own System Administrator account and add 
users to the system. The next section provides instruction on creating your 
new System Administrator account from this screen and adding additional 
users.
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2.5 Creating User Accounts

The RF ValProbe software is designed for two levels of users:

System Administrator - Creates and maintains user accounts, sets site 
options and system preferences, backs up and restores user information, and 
views, prints, and maintains the audit trail. The System Administrator also 
performs Logger calibration.

Operator - Programs Loggers, reads Loggers, creates reports, and performs 
calibration verification. Operators can also change system preferences if the 
System Administrator has enabled the Allow Operators to change 
Preferences site option.

In this section you:

• Create a new System Administrator account

• Create Operator accounts

2.5.1 Creating a New System Administrator Account

The first task you must perform when you log in for the first time is to create a 
System Administrator account. Once this is accomplished, you can add users 
(Operators or other System Administrators) to the system and set site 
options. Once your System Administrator account is created, the default 
account you used to log on to the system (Kaye/411) will be deleted. You will 
then be logged in under the user name you create.

Note: It is good practice to establish more than one individual as a System 
Administrator. This way, the Password Maintenance utility functions can still 
be accessed, even if one of the System Administrators is unavailable.

The next time you log in to the Password Maintenance utility you will need to 
enter your own System Administrator user ID and password. The Password 
Maintenance utility is able to identify you by name using your unique user ID 
and password combination.
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Note: If you want to use the Kaye RF ValProbe software to program Loggers, read 
Loggers and generate reports, create an Operator account for yourself 
using a different name and user ID than your System Administrator 
account.

1. The Password Maintenance Add New User screen should be displayed after you 
logged in to the system for the first time using the default System Administrator 
account. Enter your name (up to 32 characters) in the Name field.

The name you enter here displays in the active user list. User names must be unique. 
Once you have added your name to the active user list, you can never enter the same 
name again. Your name is associated with the unique user ID/password combination 
that you enter in steps 2 and 3. You use this user ID/password combination to log in to 
the Password Maintenance utility. The user ID and password are case sensitive.

2. Enter your new System Administrator identification in the User ID field. Your user ID 
can be any combination of numbers and characters, up to a maximum of 16. A user ID 
may not be used by more than one active account.

3. Enter your new System Administrator password in the Password field. Your password 
can be any combination of numbers and characters, up to a maximum of 16. For 
security reasons, it is preferable to use more than six characters or numbers.

4. Enter your password again in the Reenter Password field.

At this point you should record your user ID and password for future reference. You 
will need them to log in to the Password Maintenance utility. Because this is the first 
System Administrator account created, the system assumes that this is your account, 
and you will not need to change the password. However, for any additional System 
Administrator accounts created, the user will need to change the password when 
logging in for the first time.

5. The permission level is set to System Administrator by default. Click OK.

The Password Maintenance screen (shown in Figure 16 on the next page) 
appears. Your new System Administrator account name appears in the active 
user list.
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2.5.1a Creating a New System Administrator Account (cont.)

Figure 16: Password Maintenance Screen
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2.5.2 Creating Operator Accounts

Now that you have created your own System Administrator account, you are 
ready to add user accounts. All Password Maintenance activity you now 
perform will be recorded in the audit trail under your user name.

When you create user accounts, each user's name is added to the active user 
list. You assign a unique user ID for each user and a temporary password. 
The user will change the password when they first log in.

To create Operator accounts:

1. On the Password Maintenance screen, click the Users menu, and then click Create 
User. The Password Maintenance Add New User screen (shown in Figure 17 below) 
appears.

Figure 17: Password Maintenance Add New User Screen
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2. Enter the new user name (up to 32 characters) in the Name field.

The user name is associated with the user ID/password combination that you 
enter in steps 3 and 4. The user ID/password combination is used to identify 
the user to the RF ValProbe software. The name you enter here appears in the 
active user list.

Note: User names must be unique. Once a name has been used, it cannot be 
used again. You should keep a separate record of all user names that you 
assign to avoid future problems.

3. Enter the new user identification in the User ID field. The user ID can be any 
combination of numbers and characters, up to a maximum of 16. The user ID and 
password are case sensitive. A user ID may not be used by more than one active 
account.

4. Enter the new user password in the Password field. The password can be any 
combination of numbers and characters, up to a maximum of 16. The user will change 
this password when they first log in to the Kaye RF ValProbe software.

5. Enter the password again in the Reenter Password field.

At this point you should record the new user ID and password. You will need to 
supply this information to each new user. A user ID/password combination is required 
any time a user:

• Programs and/or reads Loggers

• Verifies sensor calibration

• Creates reports

• Moves or copies data files

• Changes preferences (if the System Administrator has enabled the Allow Operators to 

change Preferences site option)

6. Click Operator to set the account’s permission level.

7. The Disable User Account option allows you to deny access to the system for this 
user. For example, if you are creating an account for a user who will not need access 
to the system for several months, you may want to select this option to deny access to 
the user. You can de-select this feature once the user is ready to use the system (see 
the Kaye RF ValProbe online Help for instructions on editing user accounts).
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Select this option if you want to disable the user account.

8. Click OK.

The Password Maintenance screen (Figure 18 below) appears with the 
newly added user name in the active user list.

Figure 18: Password Maintenance Screen

9. Repeat steps 1 through 8 to add more users to the system.
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2.5.3 Printing the User List

All active and deleted user accounts are included in the printed list.

To print the user list:

1. On the Password Maintenance screen, click the File menu, and then click Print Users. 
The Windows Print dialog box appears.

2. Select a printer and click Print.

3. Click OK when prompted that the user list has been printed.

2.5.4 Selecting Site Options

The Password Maintenance utility provides site options that give users more 
flexibility while running the Kaye RF ValProbe software. To access the site 
options from the Password Maintenance screen, click File >Options. The 
System Administrator Site Options screen opens, as shown in Figure 19 
below.

Figure 19: System Administrator Site Options Screen



 Chapter 2. Installing and Using RF ValProbe Software
2.5.4 Selecting Site Options (cont.)

As the System Administrator, you can select options that will:

• Disable the user identification requirement.

IMPORTANT:If you disable the user identification requirement, the Kaye RF 
ValProbe system does not meet FDA regulations for electronic 
signatures (21 CFR Part 11).Kaye recommends that you always 
require user identification.

• Set passwords to expire after a number of days, up to 366. The user will be prompted 

to change their password once their current password has expired. By default, 
passwords are set to expire after 180 days.

• Require minimum-length passwords for all user accounts, from 1 to 16 characters.

• Disable user accounts after three unsuccessful login attempts. This option will disable a 

user account if there are three consecutive login failures for the same user ID. If a 
user's account is disabled, the System Administrator must enable the account and 
assign a new temporary password.

• Allow Operators to change Preferences. Preferences are system defaults that specify 

the temperature units, the communications port, the network ID, and when to issue low 
battery warnings. Any changes made to the system preferences are effective 
immediately, and all setups created after the preferences have been changed will 
reflect these new settings. If this option is not enabled, the System Administrator is 
responsible for changing preferences.
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2.5.4 Setting Site Options (cont.)

To set site options:

1. Select the check box next to any option to enable that option. To set the number of 
days until passwords expire, use the spin buttons to set the number of days in 30-day 
increments, or enter a number from 1 to 366 in the box. To specify a minimum 
password length, select the Require minimum password length option and use the spin 
buttons to set the password requirement from 1 to 16 characters, or enter the number 
directly into the box.

To disable an option, clear the associated check box.

2. Click OK. The Password Maintenance screen appears.

3. On the File menu, click Exit to log out of the Password Maintenance utility. The RF 
ValProbe Main Menu appears, as shown in Figure 20 below.

Figure 20: Kaye RF ValProbe Main Menu
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2.5.5 Selecting a Communications Option and Establishing 
Preference

The Kaye RF ValProbe Base Station is the communications link between the 
Kaye RF ValProbe Loggers and your computer. After installing the Kaye RF 
ValProbe software and connecting the Base Station to your PC via USB, you 
must select or confirm a communications option in order for the Base Station 
to communicate with your PC. You might also need to change the Network ID 
of your Base Station, or select the temperature displayed (in °F or °C).

To select a communication option:

1. On the Kaye RF ValProbe Main Menu, click the Preferences tab. The Change 
Preferences (Figure 21 below) dialog box appears.

Figure 21: Change Preferences Dialog Box

2. Enter your System Administrator user ID and password and click OK (you can use an 
Operator user ID and password if you have enabled the Allow Operators to change 
Preferences site option).

The Preferences screen (Figure 22 on the next page) appears.

Note: Three items on the Preferences screen appear for information purposes only 
-- the Machine ID, the Company Name and the Data Directory for backup 
files. These items are not user-selectable.
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2.5.5 Selecting a Communications Option and Establishing 
Preferences (cont.)

Figure 22: Preferences Screen

3. To select the units in which you wish to display temperature (Celsius or Fahrenheit), 
click on the appropriate radio button.

Note: This selection applies to the entire RF ValProbe --both the Base Station and 
Loggers.

4. If you are connecting an IRTD to the PC, click on the COM port to which you will 
connect the IRTD from the pull-down list.

5. The Battery Life warning signals the user to change the battery if its life drops below a 
certain percentage (from 0 to 90%). The default setting is 10%. If you want a different 
percentage, use the arrow keys to scroll to the desired percentage.
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6. Click on the desired communications option (USB or Ethernet) from the Base Station 
radio buttons. USB is the default selection. You can use USB or Ethernet, but not both 
simultaneously.

7. Click on “Change to BaseStation” check box to switch the RF hardware to be used. 
Software will restart and a screen will appear to select the RF hardware. Main Menu of 
RF ValProbe software will appear after appropriate selection of RF hardware.
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2.6 Setting Up the USB Connection

First, be sure you have selected the USB option for your Base Station on the 
Preferences screen. Also, be sure you have powered up the Base Station and 
connected it to your PC’s USB port before completing the following steps:

1. If you need to change the Base Station settings, click the Change Base Stations 
Settings button. The USB Base Station Settings window opens, as shown in Figure 23 
below.

Figure 23: USB Base Station Settings

2. A default network ID of 0 has been programmed into the Base Station. You can use this 
ID or enter a new Network ID, from 0 to 9 or A to F.

• To obtain the programmed ID, click on the Get Network ID button. The software 
obtains the programmed ID from the Base Station.

• To enter a different Network ID, use the arrow keys next to the text box.

3. Click OK to confirm the settings and return to the Preferences screen.
RF ValProbe® User Manual 47



 Chapter 2. Installing and Using RF ValProbe Software
2.6.0 Setting Up USB Connection (cont.)

Note: Be sure that the ID number at the back of each Logger matches the network 
ID number programmed in this window.

By clicking the Set USB button, you set the static IP address on your PC to 
correspond to the static IP address of the USB-to-Ethernet converter used in 
the Base Station. The software performs this function on startup, but you may 
need to perform it here if, for example, the USB cable was plugged in after 
startup.
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2.7 Setting Up the Ethernet Connection

Note: If you plan to use an Ethernet connection, please be sure the Ethernet 
cable is no longer than 30 m to the nearest hub/switch. If you switch the 
Base Station to Ethernet mode, the Base Station acquires the IP address 
by DHCP from your network during startup. Please make sure that there is 
a DHCP Server available before switching to Ethernet mode. After 
switching to Ethernet mode, the Base Station will no longer communicate 
over USB. To restore USB communication, you must establish an Ethernet 
connection.

If you want to switch to Ethernet operation, you must click on the Switch to 
Ethernet button, and follow the on-screen instructions. Be sure the Base 
Station remains connected to the USB port until you receive specific 
instructions to change the connection.

The Ethernet Base Station Settings window opens, similar to Figure 24 
below.

Figure 24: Ethernet Base Stations Settings
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2.7.0 Setting Up the Ethernet Connection (cont.)

1. To locate the Base Stations on the network, click on the Refresh Discovery button. 
The software scans the network and locates the Base Stations on the network.

2. To select and program a specific Base Station, highlight the desired Base Station in the 
Discovered Base Stations window and click on the Select Base Station button.

3. Users can either accept the network ID programmed into the Base Station or enter a 
new Network ID, from 0 to 9, or A to F. (The default ID is 0.)

• To obtain the programmed ID, click on the Get Network ID button. The software 

obtains the programmed ID from the Base Station.

• To enter a Network ID, use the arrow keys next to the text box.

4. Click OK to confirm the settings and return to the Preferences screen.

Note: Be sure that the ID number at the back of each Logger matches the network 
ID number programmed in this window.

Note: If you switch to new hardware only new base station will be displayed and 
if you switch to old hardware only old base station will be displayed. User 
cannot use old base station if he has switched to new RF hardware

If you want to return to USB operation, click the Switch to USB button while 
the Ethernet cable remains plugged into the Base Station. Then follow the 
on-screen instructions.
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2.8  Viewing the RF ValProbe Hardware Inputs

Once you have set up your Loggers and Base Stations and established your 
Preferences, you can view the RF ValProbe system on the Hardware tab, to 
ensure that the system is functioning properly.

From the Main Menu or the Preferences tab, click on the Hardware tab. The 
Hardware screen initially appears blank. As the software receives data from 
the Base Station and Loggers, it appears similar to Figure 25 below.

Figure 25: Hardware Screen Identifying Loggers

Once the software has established data inputs from the Base Station and 
Loggers, the screen appears similar to Figure 20 on the next page, with the 
temperature and humidity displayed.

IMPORTANT:

• Single channel temperature logger is treated as humidity/temperature logger with no 

humidity sensor present.

• Repeater logger is treated as humidity/temperature logger with no humidity sensor 

and no temperature sensor present. Serial number of repeater logger always starts 
with either "R" or "r".
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

• Software will automatically include single channel temperature logger for 

programming even if humidity sensor value is not available.Similarly, software will 
automatically exclude repeater logger from programming.

• Humidity value will be displayed as 398.4 in reports for Single channel temperature 

logger.

Figure 26: Hardware Screen with Data Inputs Established

As the RF ValProbe locates and retrieves data for Loggers via the Base 
Station, it displays Logger status via a variety of brief messages:

• Searching -- Logger is detected, and the system is getting more information. It may be 

ready to use.

• Found -- Logger is available, and ready to use.

• Starting - The software is asking each Logger to start collecting data at the specified 

rate and at the specified time, but the Logger has not yet acknowledged that it has 
begun the program.

• Logging -- The Logger is currently running in a study.

• Running -- The Logger is programmed and waiting to run in a study at a specified time.
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

• Waiting -- The expected readings/samples are late in arrival, due, perhaps, to poor RF 

communications or a stopped logger.

• Ready to Read -- The Logger has completed its study.

• Retrieving -- The system is obtaining data from the Loggers.

Note: When the system is Re-reading Loggers, even if the Logger is turned OFF, 
you can read the Logger data from the Base Station. Kaye recommends 
leaving the base station and loggers turned ON until the study is read, to 
avoid any issues retrieving data.

• Read -- The system is reading the Logger samples.

• Done -- The reading is complete.

• Configuring -- The system is uploading or sending calibration/verification information to 

the Logger.

• Stopping -- The software sends Stop Data Collection to the logger when the run is 

ended.

• Requesting -- The system is getting additional or needed readings/samples from the 

Logger.

• Failed Update -- For calibration or verification, the system failed to update Loggers. 

Consult Kaye.
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

The screen offers several additional display and information options:

• To view real-time data from one or more Loggers in graph format, highlight one or 

more Loggers in the list (use Ctrl + click to select two or more Loggers) and click on the 
Graph Sensors button or click File>Graph Sensors from the File menu. A blank graph 
screen appears, similar to Figure 27 below.

Figure 27: Real-Time Graph Screen
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

Data logging begins when you have started the Graph option. To plot the data 
collected prior to starting the real time graph, click the History Graph check 
box; the software will read historical data from the Base Station and plot it in 
the real time graph. Once the historical data has been read and plotted, the 
History Graph check box will be disabled. After a few minutes, the screen 
appears similar to Figure 28 below.

Figure 28: Real-Time Graph Screen Displaying Data
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

You can select the type of sensor displayed, copy and print the graph, and 
choose from a number of graph options.

• To view Base Station information, you can click on the Base Station icon , or click 

View Options>RF Base Station from the View Options menu. The Base Station 
window lists serial number, IP address, Network ID and Base Station name.

• To customize your view of the Hardware screen, click on the Customize Column 

Layout icon , or click View Options>Customize Column Layout from the View 
Options menu. In addition to Status, Logger model number, and current temperature 
and humidity readings, you can select or deselect auxiliary inputs and contacts, 
percentage of battery life remaining, stability, calibration and calibration verification 
dates, probe ID, firmware version, RF strength, number of readings and time received.

• To refresh the view click the Refresh view button . This button reloads and 

redisplays information on Hardware view screens when the initial view of the Loggers or 
the commands sent to Loggers do not appear. Try clicking the Refresh button if a 
screen or a process seems to be stopped or frozen.

• To view and graph the RF Strength of the various RF strengths of signal paths, click 

Map RF Strength from the File menu. The Logger Network Strength Graph screen 
opens, displaying the paths and their signal strengths. You can add a background 
diagram or photo (as shown in Figure 29 on the next page) on which the software will 
superimpose the signal path graph.

Note: Signal strength loading for the first time will take approximately 15 minutes. 
Mapping RF strength will function only after the signals have been loaded.
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2.8 Viewing the RF ValProbe Hardware Inputs (cont.)

Figure 29: Logger Network Strength Screen

• To print a Logger list report from the current screen view, click on the Print button, or 

click File >Print Logger list report from current view from the File menu.

• To return to the Main Menu, click on the Main Menu button.
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2.9 Accessing the Kaye RF ValProbe Online Help

The RF ValProbe online Help provides step-by-step instructions for using the 
software, including: programming Loggers, reading Loggers, creating 
reports, and performing calibration verification.

Note: The Kaye RF ValProbe online Help will work with Internet Explorer 4 or later, 
however, Internet Explorer 11 or later is recommended.

To access online Help:

• With the Kaye RF ValProbe program running, click the Help tab.

The Kaye RF ValProbe Help window (shown in Figure 30 below) appears.

Figure 30: RF ValProbe Help Window

Click on the Contents and Index tab to access specific Help features.
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2.9.1 Tabs

• The following tabs and buttons are available to assist you in navigating Help:

• The Contents tab displays the Table of Contents. Click a book to display the pages in 

that book. Click a page to view the corresponding help topic in the right-hand window.

• The Index tab displays the Index. Enter the keyword to search for, select it from the list, 

and click Display to view the associated topic.

• The Search tab provides full-text search capabilities. This feature enables you to 

search the entire Help system for a word or phrase. Enter the word or phrase and click 
List Topics. Select a topic from the list and click Display. The word or phrase you 
searched for will be highlighted in the topic text.

• The Favorites tab enables you to store a list of your favorite or most frequently used 

Help topics. Whenever you open Help, you can quickly go to the topics you view most 
often by selecting them from this tab. When a topic you would like to store in the 
favorites list is displayed in the right-hand pane, click Add. You can update the list at 
any time by removing topics you no longer want to mark as favorites.
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2.9.2 Buttons

• The Show/Hide buttons show or hide the left pane of the Help window. When you 

access Help for individual screens within the Kaye ValProbe software, you can use the 
Show button to access the Contents, Index, Search, and Favorites tabs. Use the Hide 
button to view a topic only and provide more room on your screen.

• The Back button returns you to the previously viewed Help topic.

• The Forward button opens the next topic in a previously viewed sequence.

• The Print button prints the current Help topic to your default printer.

• The Options button opens a menu that provides access to the Show/Hide, Back, 

Forward, and Print features, in addition to:

• Home - Links to the website.

• Stop - Stops loading a new topic or stops downloading information (click this option 

to stop a Web page from opening).

• Refresh - Updates the topic content displayed in the topic pane.

• Search Highlight On/Off - When this option is enabled (default setting), words 

entered using the Search feature are highlighted in the topic text

2.10 Screen-Level Help

You can also access online Help for individual screens in the RF ValProbe 

software by clicking the button in the lower right corner of the screen, or 

by pressing F1.
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Appendix A. Specifications

A.1 RF ValProbe System Specifications

A.1.1 RF System Operating Frequency

2.4 GHz

A.1.2 RF Certification

USA, Canada, EU (CB scheme). For other, contact factory.

A.1.3 Number of Loggers

Up to a maximum of 40 Loggers per Base Station.

A.1.4 Transmission

Maximum antenna to antenna distance in open space: 150 ft (45m)

A.1.5 PC Update Rate 

10 seconds maximum

A.1.6 Maximum Network Form Time 

• For 8 Loggers evenly distributed over 5 cubic ft / 0,15 m3: typical, 2 minutes

• For 12 Loggers in a 30 ft (9m) radius single plane, typical, 4 minutes

A.1.7 Data Retention

Loggers retain up to 10,000 data samples per sensor.
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A.2 Base Station 

Autonomous Base Station operation configuration. The external connection 
(Ethernet or USB) to the Base Station can be broken and reconnected at any time 
with no interruption in system operation and no loss of data.

A.2.1 Connections

Ethernet full speed, Cal PC for IRTD and BATH

Note: Connections are mutually exclusive.

A.2.2 Power

Power Adapter
Input: 100 to 240 Volts AC
50-60 Hz input
Battery: Two 3.7V AA size secondary (Rechargeable) batteries

A.2.3 Indicators

Power, RF Link, Study, Mains/Battery supply
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A.3 Logger

A.3.1 Measurement Types

• Temperature

• RH

• 4-20 mA input

• 0-10 voltage input

• Contact Closure

A.3.1a Sensor Configurations

T with external temperature sensor

T/RH with external temperature sensor 

T/RH with external temperature sensor, 0-10 V input, contact closure T with two 
external temperature sensors

T/RH with external temperature sensor, 4/20 mA input, contact closure

T with five external temperature sensors

Table 3: Sensor Configurations

Model # RTD1 RTD2 RTD3 RTD4 RTD5 RH Voltage Current Contact

X3001D-0-0 √

X3001D-H-0 √ √

X3001D-H-V √ √ √ √

X3001D-H-A √ √ √ √

X3002D-2 √ √

X3002D-5 √ √ √ √ √

X3001N-R
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A.3.2 Environmental

A.3.2a Logger Body (Enclosure)

-40°C to 60°C, 0 to 90% RH non-condensing….Storage Temperature

-25°C to 60°C, 0 to 90% RH non-condensing….Operating Temperature

Note: Logger on Battery mode only (Logger External Power adapter rated for 
operating temperature 0°C to 60°C)

A.3.2b Base Station Body (Enclosure)

-40°C to 60°C, 0 to 90% RH non-condensing….Storage Temperature

0°C to 50°C, 0 to 90% RH non-condensing…....Operating Temperature

A.3.2c Logger External Probe

-196°C to 200°C

A.3.2d Logger Dimensions

110 mm x 65 mm x 30 mm (4.3 in x 2.6 in x 1.2 in)

A.3.2e Base Station Dimensions

190 mm x 130 mm x 55 mm (7.6 in x 5.2 in x 2.2 in)

A.3.3 Accuracy

A.3.3a Temperature-Validation (External Sensor)

Single / Multi Channel External Sensor

±0.1°C, range -50°C to +130°C
±0.2°C, range -80°C to -50°C
±0.5°C, range -80°C to -22°C
Accuracy for -196°C to -80°C & +130°C to 200°C ...Contact Factory
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A.3.3b Relative Humidity

±2.0% from 25% to 85% RH at 25°C to 40°C (Non-condensing environment)
Certificate states ICH Points

A.3.3c Auxiliary Inputs

3.8 to 22 mA Input, 16 bit A/D input, accuracy: 0.5% FS 0 to 10 V input, 16 bit 
A/D input, accuracy: 0.5% FS Contact Closure (dry)

A.3.3d Sensor Sampling Rate

5 seconds maximum, 12 hours minimum

A.3.4 Battery / Power Supply

Logger Battery Life (Varies ±10% @ 25°C)

1 minute samples: 1 Year with Kaye recommended battery

Note: Additional factors impacting battery life are RF network configuration, 
sampling rate, temperature, LCD operation and SD card operation.

Battery Type: Kaye# 200-165, 2 AA Lithium primary (Non-rechargeable) 
Batteries- 2600mAH 

Power Adapter: Input: 100 to 240 Volts AC 50-60 Hz input

CAUTION! If it becomes necessary to replace a Logger battery, use only 
Kaye# 200-165, 3.6 V Lithium primary (Non-Rechargeable) 
battery. Use of any other battery will void your Logger warranty.

A.3.5 Logger Indicators

• Power

• RF Link
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A.3.6 Logger Timing

Date and Time stamp required for each sensor reading

Time synchronization: 15 sec/day minimum

Indication of logger loss of communications interval: either 2 samples or 15 
minutes (whichever is less)

A.3.7 Logger Storage 

Non-volatile storage up to 10,000 data samples per sensor

A.4 Environmental/EMC

A.4.1 EMC-EN61326 

A.4.1a Base Station Emissions classification: Class A

Immunity classification: Table A1, Annex A, for use in industrial locations 
Performance Criteria: Continuous unmonitored operation

A.4.1b Logger

Emissions classification: Class A

Immunity classification: Annex C, Table C1, portable and battery operated 
equipment
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Appendix B.Environmental Compliance

This appendix contains information on the following topics:

• WEEE Directive (see Section B.1 on page 73)

• Battery disposal (see Section B.2 on page 74)

B.1 Waste Electrical and Electronic Equipment (WEEE) 
Directive

Amphenol Thermometrics, Inc. is a participant in Europe’s Waste Electrical and 
Electronic Equipment (WEEE) take-back initiative, directive 2002/96/EC.

The equipment that you bought has required the extraction and 
use of natural resources for its production. It may contain 
hazardous substances that could impact health and the 
environment.

In order to avoid the dissemination of those substances in our 
environment and to diminish the pressure on the natural 
resources, we encourage you to use the appropriate take-back 
systems. Those systems will reuse or recycle most of the 

materials of your end life equipment in a sound way.

The crossed-out wheeled bin symbol invites you to use those systems.

If you need more information on the collection, reuse and recycling systems, 
please contact your local or regional waste administration.

Contact your Amphenol Thermometrics, Inc. team for additional take-back 
information.
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B.2 Battery Disposal

This product contains a battery that cannot be disposed of as 
unsorted municipal waste in the European Union. See the 
product documentation for specific battery information. The 
battery is marked with this symbol, which may include lettering 
to indicate cadmium (Cd), lead (Pb), or mercury (Hg). For 
proper recycling return the battery to your supplier or to a 
designated collection point.

B.2.1 What do the Markings Mean?

Batteries and accumulators must be marked (either on the battery or accumulator 
or on its packaging, depending on size) with the separate collection symbol. In 
addition, the marking must include the chemical symbols of specific levels of toxic 
metals as follows:

• Cadmium (Cd) over 0.002%

• Lead (Pb) over 0.004%

• Mercury (Hg) over 0.0005%
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B.2.2 The Risks and Your Role in Reducing Them

Your participation is an important part of the effort to minimize the impact of 
batteries and accumulators on the environment and on human health. For proper 
recycling you can return this product or the batteries or accumulators it contains to 
your supplier or to a designated collection point.

Some batteries or accumulators contain toxic metals that pose serious risks to 
human health and to the environment. When required, the product marking 
includes chemical symbols that indicate the presence toxic metals: Pb for lead, Hg 
for mercury, and Cd for cadmium.

• Cadmium poisoning can result in cancer of the lungs and prostate gland. 
Chronic effects include kidney damage, pulmonary emphysema, and bone 
diseases such as osteomalcia and osteoporosis. Cadmium may also cause 
anemia, discoloration of the teeth, and loss of smell (anosmia).

• Lead is poisonous in all forms. It accumulates in the body, so each exposure is 
significant. Ingestion and inhalation of lead can cause severe damage to 
human health. Risks include brain damage, convulsions, malnutrition, and 
sterility.

• Mercury creates hazardous vapors at room temperature. Exposure to high 
concentrations of mercury vapor can cause a variety of severe symptoms. 
Risks include chronic inflammation of mouth and gums, personality change, 
nervousness, fever, and rashes.
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[no content intended for this page - proceed to next page]
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Warranty

Each instrument manufactured by Amphenol Advanced Sensors is warranted to 
be free from defects in material and workmanship. Liability under this warranty is 
limited to restoring the instrument to normal operation or replacing the instrument, 
at the sole discretion of Amphenol Advanced Sensors. Fuses and batteries are 
specifically excluded from any liability. This warranty is effective from the date of 
delivery to the original purchaser. If Amphenol Advanced Sensors determines that 
the equipment was defective, the warranty period is:

• one year for general electronic failures of the instrument

• one year for mechanical failures of the sensor

If Amphenol Advanced Sensors determines that the equipment was damaged by 
misuse, improper installation, the use of unauthorized replacement parts, or 
operating conditions outside the guidelines specified by Amphenol Advanced 
Sensors, the repairs are not covered under this warranty.

The warranties set forth herein are exclusive and are in lieu of all other 
warranties whether statutory, express or implied (including warranties or 

merchantability and fitness for a particular purpose, and warranties arising 
from course of dealing or usage or trade).
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Return Policy

If a Amphenol Advanced Sensors instrument malfunctions within the warranty 
period, the following procedure must be completed:

1. Notify Amphenol Advanced Sensors, giving full details of the problem, and 
provide the model number and serial number of the instrument. If the nature of 
the problem indicates the need for factory service, Amphenol Advanced 
Sensors will issue a RETURN AUTHORIZATION number (RA), and shipping 
instructions for the return of the instrument to a service center will be provided.

2. If Amphenol Advanced Sensors instructs you to send your instrument to a 
service center, it must be shipped prepaid to the authorized repair station 
indicated in the shipping instructions.

3. Upon receipt, Amphenol Advanced Sensors will evaluate the instrument to 
determine the cause of the malfunction.

Then, one of the following courses of action will then be taken:

• If the damage is covered under the terms of the warranty, the instrument will be 
repaired at no cost to the owner and returned.

• If Amphenol Advanced Sensors determines that the damage is not covered 
under the terms of the warranty, or if the warranty has expired, an estimate for 
the cost of the repairs at standard rates will be provided. Upon receipt of the 
owner’s approval to proceed, the instrument will be repaired and returned.
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